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Section 1 - Using This Manual 
This manual contains operation information for the NT2-210019 DWDM Optical Time Domain Reflectometer (OTDR). 
This OTDR may be operated by using the touchscreen or the onboard key pad. The touchscreen is a resistive style 
screen and only proper stylus devices should be used when operating the OTDR using the touchscreen capability.

This guide is written to instruct operation via the onboard keypad. There will be tips throughout the manual to 
assist with touchscreen operation.

Precautions
Optical time domain reflectometers are optical instruments that do emit laser radiation and though this level of 
radiation is not considered a danger, there are safety considerations and certain practices that should be followed.

Please read and follow all warning and caution information noted in this manual.

Warning
• A warning alerts to situations that could cause personal injury.
Caution
•   A caution alerts to situations that may cause damage to the equipment or produce poor testing 

conditions, resulting in inaccurate test results.
Note
• A special annotation that will assist the user with operational features.
Touch Screen Tip
• These tips will be found throughout the manual to assist with touchscreen operation.

Section 2 - Safety
Section 3 of this manual is a quick start guide. Prior to using the quick start guide or operating the equipment in 
any way, it is highly suggested the user reads all safety information.

The information in this chapter pertains to safety consideration of OTDRs in general.

This product has been designed and tested in accordance with the manufacturer’s safety standards, and has been 
supplied in a safe condition.

This document contains information that must be followed by the user to ensure safe operation and to maintain 
the product in a safe condition. Failure to follow these safety warnings and cautions can result in harm to the user 
or damage to the instrument.

Warning
 Personnel should always be aware when working with fiber optic test equipment that active fibers may  
be present and therefore infrared optical energy may be present.

Warning
 Never look directly into the end of a connected fiber optic cable or fiber optic adapter of test equipment. To do 
so could expose the user to laser radiation and could result in severe personal injury.
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Warning
To Prevent Fire or Shock Hazard:
• Do not install battery types other than those specified by the manufacturer
• Do not use the charger without the batteries installed
• Do not expose the battery charger to rain or excessive moisture
• Do not use the AC adapter when there are signs of damage to the enclosure or cord
• Ensure you are using the correct charger for the local line voltage
• Do not use any other charger than the one provided with this instrument.
• Failure to follow these cautions may damage the equipment and void the warranty

Caution
Fiber optic connectors are easily contaminated or damaged. The connection to the OTDR is physical contact 
type of connections and dirty or damaged connectors may impair the instrument's capabilities at minimum 
and, at worst, result in the need to return the OTDR to the factory for expensive repairs. Prior to making any con-
nection to the unit, ensure all proper cleaning procedures have been followed. Use UPC Finish Connectors Only 
-- DO NOT insert APC connectors into the optical ports.

Caution
The OTDR is equipped with a protection circuit to avoid damage from live fiber connections. The instrument 
will not operate properly with active fibers. Even with this protection, high power output from EDFA’s or other 
equipment can damage detectors and should never be connected to the OTDR.

If a live fiber is connected to the OTDR and a scan is attempted, a warning dialog will be displayed as in fig. 2.1. 
Immediately remove the live fiber from the OTDR and press Select to continue testing.

Fig 2.1
Section 3 - CO- OTDR Quick Start Guide

Press the POWER button to turn on the OTDR

This quick start guide demonstrates use by way of the touchscreen unless the keypad is required.

 Touch the OTDR icon located in the center of the Home screen.

 Connect the fiber to the appropriate OTDR Optical Port

   Touch the (wavelength (Lambda) icon) on the left side of the parameter area of the display to bring up the 
wavelength selection pages. Touch the desired wavelength for testing or select the next page.

If approximate fiber length is unknown:

  Press to have the OTDR start a test using the selected wavelength with the OTDR determining the most 
appropriate range and pulse width.
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If approximate fiber length is known:

 Set the Wavelength as previous.

  Touch the Average icon to cycle through the available averaging times of Real-Time, 15 seconds; 1, 4,  
16 or 40 minutes

  Touch the Pulse Width icon to cycle through the available pulse widths of 5ns, 10ns, 30ns, 100ns, 300ns, 
1us, 3us, 10us or 20us. (Not all pulse widths will be available, only pulse widths appropriate for the selected 
range will be presented)

  Touch the Range icon to cycle through the available ranges of 500m, 1km, 4km, 16km, 64km, 128km  
or 256km

 Touch Scan or press the Scan button to start a trace. A second touch or press will stop a trace.

  To operate the cursors, touch the A -> B area of the screen or press the A/B button to toggle between A and 
B as the active cursor. To move the cursors, with the desired cursor as the active cursor (solid vertical cursor 
line), touch the screen and the cursor will snap to that location; leave the cursor in contact with the display 
and drag the cursor to the desired location. The left and right buttons on the display may also be used.

 To view the event table with the trace, touch the Event tab in the center of the display.

 To view the schematic with the trace, touch the Schematic tab in the center/right of the display

  To save a Trace, touch the Menu button and use the left or right buttons to highlight the Quick Save icon 
and touch it or press Select . The file will be saved to the active folder.

Section 4 - Introduction
  Dear Valued Customer, 

Thank you for choosing PPC for your fiber optic testing requirements. Our professional staff  
is available to answer any questions or provide assistance that you require. At PPC, we strive 
to provide premier customer care and technical support by providing timely responsiveness  
and training. We are proud of our quality and high standards and assure you, our customer,  
the most user-friendly and affordable fiber optic solutions to meet your individual needs.

Section 5 - Inspection and Identification
5.1 Inspection 
Before shipment, this instrument was inspected and found to be in perfect working order and free of defects.

The shipping carton contains the following:

1. OTDR with Protective boot

2. Universal AC/DC charger with interchangeable mains

3. USB cable

4. Manual and CertSoft software on CD

5. Set of interchangeable adapters: SC, and FC
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5.2 Identification and Configuration
The instrument’s Model/Part Number, Serial Number and Date of Manufacture are indicated on a label located on 
the back of the unit. The instrument’s history is filed at the factory by Model/Part Number and Serial Number. The 
unit's Serial Number is also located on the top plate just above the USB Port.

Fig 5.1
Section 6 - Description
6.1 OTDR Physical Description
Instrument Enclosure
The NT2-210019 is packaged in a rugged housing, which is further protected with a rubberized boot. Although the 
front panel is weather resistant, care must be taken to avoid liquids and contaminants around the fragile optical 
and electrical connectors, and the glass display. Use a mild cleaning agent and soft damp cloth to clean the panels 
and the outside case. See the maintenance section to clean the optical connector. NEVER open the instrument for 
cleaning. Return to the factory for servicing if necessary.

Front Panel

Fig 6.1
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Top Plate

Fig 6.2
6.2 Home Screen Display
This unit is equipped with a 4” color TFT resistive touch display. All keyboard functions are also executable on the 
touchscreen.

Fig 6.3
Touch Screen Tip
The Home Page icons are highlighted by using the left and right buttons. Pressing the Select button  
will open the highlighted function. These icons may also be selected with the touchscreen function.

6.3 Power Requirements
The NT2-210019 is equipped with a 100-240V-0.4A input universal battery charger with 15V, 1.2A, (center positive 
output). The charger is supplied with interchangeable mains plugs for North America, Great Britain, Europe and 
Australia. The unit's internal power supply is an 11.1V 2600 mAh Li-ion battery. Typically, fully discharged batteries 
require 2 hours of recharging.
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6.4 Battery Replacement
Batteries are factory installed. The unit should be returned to the factory for a new battery if required. It is 
suggested batteries receive a charge at least one a month.

Warning
To Prevent Fire or Shock Hazard:
• Do not install battery types other than those specified by the manufacturer
• Do not use the charger without the batteries installed
• Do not expose the battery charger to rain or excessive moisture
• Do not use the AC adapter when there are signs of damage to the enclosure or cord
• Ensure the correct charger is being used for the local line voltage
• Do not use any other charger than the one provided with this instrument
•  Failure to follow these caution statements could cause unsafe conditions for the operator and  

equipment and may void the warranty

Section 7 - OTDR Operation
7.1 Key Pad
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7.2 Entering OTDR Function
Press the Power button to turn on the OTDR.

Use the LRUD button buttons to highlight the OTDR icon and press the Select button to enter the OTDR function.

7.3 Icon Definitions
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7.4 Main OTDR Screen

Fig 7.2
Touchscreen Tips
Use the touchscreen to snap cursors to a position by touching that point along the trace curve. The active 
cursor will move directly to that point. For finer movement, touch the active cursor and drag it to the desired 
position. Finest movement can be accomplished with the LRUD buttons.

All the test parameters may be changed by touching the value on the touchscreen. A long touch in the test pa-
rameter section of the screen will open the Parameter Settings page. A/B cursor, zoom, loss method and scan 
may all be operated with the touchscreen.

Fig 7.3
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There are three tabs on the main OTDR screen: OTDR, Events and Schematic. Use the OTDR tab to view the trace 
with the loss and distance measurements. Use the Events tab to view an interactive event table with the trace and 
numbered events or the Schematic tab to view an interactive schematic view of the events with the trace and 
numbered events. Selecting an event in the event table or the schematic view will snap the active cursor to that event.

7.5 OTDR Parameter Settings Screen
To access the Parameter Settings screen, press the Menu button, use the LRUD buttons to highlight the Setting 
icon and press the Select button. An alternate manner to open this screen is to long touch the screen in the test 
parameter section of the main OTDR screen.

Touchscreen Tip
All operations on this page are accessible via the touchscreen. To change parameters or event sensitivity,  
simply touch the desired value. To set thresholds and time, touch the setting and the block will show  
yellow. The digits may now be adjusted with the up and down arrows.

Fig 7.4
Trace Parameter Settings
The cursor is the yellow highlighted area. If the yellow cursor is on a value that is selected, that block will be 
highlighted green. The blue values are the currently selected values. To move through this section, use the Up/
Down buttons to move between parameters and the Left/Right buttons to change parameter values.

There are two additional setting in this area that are not available on the main OTDR screen: Distance Unit and Pulse 
Width Unit.

Touchscreen Tip
When using the touchscreen feature, only a single touch is required to set trace parameters.

Note
An arrow at the beginning or end of a list indicates additional settings are available. A black square at either 
end indicates the end of the list.
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Event Table/Fib-R-Map Sensitivity Settings
The cursor is the yellow highlighted area. If the yellow cursor is on a value that is selected, that block will be 
highlighted green. The blue values are the currently selected values. There are three levels of sensitivity for the 
event table and Fib-R-Map. The lowest setting possible should be used to help filter out any events that may be 
caused by short pulse widths, but are not true perturbations in the optical signal.

Pass/Fail Threshold Settings
There are five pass/fail thresholds that may be set. Use the LRUD buttons to move between threshold categories. 
Once a category is highlighted, press Select to change the focus of the LRUD buttons. Use the up/down button to 
make changes to the highlighted digit and the left/right buttons to move the another digit. Once the desired value 
is entered, press Select again. Continue until all threshold settings have been completed.

Note
There is an ORL threshold and a reflection threshold setting. The ORL is the return loss for the entire  
link/system and reflection threshold is the return value of a given event.

Date/Time Settings
Use the LRUD buttons to highlight the calendar month and press Select. Use the left and right buttons to change 
the month and press Select. Use the LRUD buttons, highlight the date and press Select.

Use the LRUD buttons to highlight the clock and press Select. Use the up/down buttons to make changes to the 
highlighted digit and the left/right buttons to move another digit. Once the desired time is entered, press Select.

Exit Parameter Setting Screen
Press the Menu button or touch Return to exit the parameter page.

Warning
Before connecting a patch cord or fiber under test, be certain the fiber has no active optical sources or  
instruments connected to the other end. Skin or eye damage could result from other high power sources  
(EDFAs) or instrument damage could occur, voiding the warranty.

Warning
Clean connector thoroughly prior to connection to the appropriate port of the OTDR. Failure to ensure  
the connectors used with the OTDR are properly cleaned can result in poor launch conditions or damage to 
the optical interface, which will require the unit be returned to the factory for repair.

7.6 Auto Test
Auto Test is a useful feature when the approximate length of the fiber to be tested is unknown. To use the Auto Test, 
only the IOR and Wavelength need to be set by the user.

Note
To assist in obtaining reliable, consistent measurements, the user should be aware of the Index of  
Refraction (IOR) of their fiber. The proper IOR will maximize the distance measurement  
accuracy. The IOR is proportional to the speed of light in glass compared to the speed of light in a  
vacuum and can be calculated using the equation IOR = C (the speed of light in a vacuum) / V (the  
speed of light in fiber). The IOR number can be obtained from the fiber or cable manufacturer or can  
be calculated with a known length of cable. IOR numbers generally fall around 1.468 SM, 1.486 MM.  
These are the default values in the OTDR, but can be adjusted from 1.0 to 2. If this is unknown it is best  
to use the default setting on the OTDR.
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Set IOR
It is necessary to have the IOR set as close as possible to the actual IOR of the fiber. If this is unknown, it is best to 
use the default setting on the OTDR. To view the current IOR for a wavelength, open the Menu, use the left/right 
button to highlight the IOR Icon, press Select and the IOR for the active wavelength will be displayed. To change 
the IOR, use the onscreen QWERTY keyboard to enter the new value and touch Save. Each wavelength stores an 
independent IOR.

Set Wavelength
To select the wavelength, press the Menu button to display the menu at the top of the display. Use the LRUD 
buttons to highlight the Lambda (Wavelength) icon, press Select to open the page with available wavelengths 
displayed. Use the touchscreen to select a wavelength or move to the next page of available wavelengths.

Start Auto Test
Press the Auto Test button and the unit will set the average time to short, the appropriate pulse width and range 
parameters for the fiber under test.

Warning
Before connecting a patch cord or fiber under test, be certain the fiber has no active optical sources or  
instruments connected to the other end. Skin or eye damage could result from other high power sources  
(EDFAs) or instrument damage could occur, voiding the warranty.

Warning
Clean connector thoroughly prior to connection to the appropriate port of the OTDR. Failure to ensure  
the connectors used with the OTDR are properly cleaned can result in poor launch conditions or damage to 
the optical interface, which will require the unit be returned to the factory for repair.

7.7 Manual/Expert Mode

Note
To assist in obtaining reliable, consistent measurements, the user should be aware of the IOR of their fiber. 
The proper IOR will maximize the distance measurement accuracy. The IOR is proportional to the speed of 
light in glass compared to the speed of light in a vacuum and can be calculated using the equation IOR = C 
(the speed of light in a vacuum) / V (the speed of light in fiber). The IOR number can be obtained from the 
fiber or cable manufacturer or can be calculated with a known length of cable. IOR numbers generally fall 
around 1.468 SM, 1.486 MM. These are the default values in the OTDR, but can be adjusted from 1.0 to 2. If 
this is unknown, it is best to use the default setting on the OTDR.

Set IOR
It is necessary to have the IOR set as close as possible to the actual IOR of the fiber. If this is unknown, it is best to use 
the default setting on the OTDR. To view the current IOR for a wavelength, open the menu, use the left/right button to 
highlight the IOR icon, press Select and the IOR for the active wavelength will be displayed. To change the IOR, use the 
onscreen QWERTY keyboard to enter the new value and touch Save. Each wavelength stores an independent IOR.

Touchscreen Tip
All the test parameters may be changed by touching the value on the screen to the right of the icon. A long touch 
in the test parameter section of the screen will open the Parameter Settings page.
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Set Wavelength
To select the wavelength, press the Menu button to display the menu at the top of the display. Use the LRUD 
buttons to highlight the Lambda (Wavelength) icon, press Select to open the page with available wavelengths 
displayed. Use the touchscreen to select a wavelength or move to the next page of available wavelengths.

Note
When setting the Range and Pulse Width, it is necessary to keep in mind that it may not be beneficial  
to use certain pulse widths with some ranges. For this reason, not all pulse widths are available for use  
with all rangers. The chart below the pulse widths that are available with each range.

Set Range
To set the Range, press the Menu button and use the LRUD buttons to highlight the Range icon. Use the Select 
button to cycle to the desired range.

Set Pulse Width
To set the Pulse Width, press the Menu button and use the LRUD buttons to highlight the Pulse Width icon. Use the 
Select button to cycle to the desired pulse width.

Set Averaging Time
To set the Averaging Time, press the Menu button and use the LRUD buttons to highlight the Averaging icon. Use 
the Select button to cycle through the averaging times of RT (Real Time), 15, or 60 seconds, 2 or 4, 8 or 20 minutes.

Touchscreen Tip
The above setting may be made with the touchscreen by simply touching the appropriate icon in the Icon 
Menu to cycle through the available settings. Also the Parameter Settings page may be opened and all set-
tings may be made on this screen.

Scan
Once all the proper settings have been entered, press the Scan button to take the trace. To stop the trace, press the 
Scan button again.

7.8 Trace Analysis
Unit of Measure
The distance unit of measure may be either displayed in Kilometer (Km), Kilo feet (Kf ) or Miles (Mi). To set the unit 
of measure, press the Menu button, use the LRUD buttons to highlight the Settings icon and press Select to open 
the Parameter screen. Use the down button to move the cursor to the D.Unit line in the Parameter menu, and use 
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Pulse Width

Ra
ng

e

5ns 10ns 30ns 100ns 300ns 1μ 3μ 10μ 20μ

500m ü ü ü ü ü
1km ü ü ü ü ü
4km ü ü ü ü ü

16km ü ü ü ü ü
64km ü ü ü ü ü

128km ü ü ü ü ü
256km ü ü ü ü ü
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the left or right button to highlight the desired unit of measure and press Select. Press the Menu button or touch 
Return to exit the Parameter Settings page.

Note
When in the Kilo feet (Kf ) mode, the distance measurements are displayed in feet for the 820 foot and the 3.2 
Kf ranges. All longer ranges have the distance measurements displayed in Kf.

Zoom
There are six Zoom levels: 1x, 2x, 4x, 8x,16x and 32X. To change the Zoom level, press the Zoom button on the 
keypad. This will cycle through the six levels. When viewing the trace at a zoom level other than 1x, the active 
cursor is centered on the trace display and when the cursors are moved, the trace moves and the cursor will 
remain centered.

Cursor Movement
The active cursor is displayed as a solid line and the non-active cursor as a dashed line. Pressing the A/B button on the 
keypad toggles between the two cursors as the active cursor. The cursors are moved using the left and right buttons.

Touchscreen Tip
Use the touchscreen to snap cursors to a position by touching that point along the trace curve. The active cursor 
will move directly to that point. For finer movement, touch active cursor and drag it to the desired position. The 
finest movement can be accomplished with the left and right buttons.

7.9 Loss Measurements
2 Point loss
2 Point loss measurements take into account the difference in vertical height between where the A and B cursors cross 
the fiber trace to determine loss. This information is located on the main OTDR screen in the A-B section of the trace 
information, as shown in Fig. 7.2. This is a quick method of checking the loss between any two points on a fiber optic link.

dB/km
The dB/Km (dB/Kft or dB/Mi) loss method takes the 2 Point loss in dB and divides by the distance between the 
cursors in Km (Kilometers), Kf (Kilofeet) or Mi (Miles). For accurate dB/.... loss measurements, the two cursors must 
be on level back scatter points at least 100m apart (NA will show for distances that are too short).

Optical Return Loss
This Optical Return Loss (ORL) is separate from the event ORL (Reflectance) that is displayed in the event analysis 
under the TYPE header for an individual event. The measurement displayed in the loss measurement area of the 
main OTDR screen and in the E (End of Fiber) row in the TYPE column is an optical return loss based on the entire 
link. It is the total accumulated light reflected back to the source along the telecommunication link.

Basic Splice Loss
Splice Loss method is meant to be used in noisy environments when it is difficult to attain an LSA area that lays flat 
on the back scatter before and after the cursor. This method takes an average of the selected points before and 
after the active cursor and uses this average to make a good estimation of the event loss. This is an estimation, but 
this method may be more accurate than LSA Splice Loss method in noisy environments.

When using the splice loss, it is necessary to set these areas in clear back scatter (areas that do not consist of other 
events) to acquire the most accurate measurements. For accurate measurements, these areas can not include other 
events such as reflective or splice events. Set a cursor at the beginning of an event and set splice loss measurement 
areas as directed, and as shown in Fig. 7.6, for accurate splice loss measurements. Splice loss measurement areas 
will follow the undulations of the back scatter line unlike LSA areas.
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Least Squares Approximation (LSA)
Least Squares Approximation (LSA) Splice loss method gives the user a visual aid in setting splice loss areas. This 
method can be more accurate by affording the ability to see the slope of the splice loss areas, however, it can also 
supply a reading with greater error if not used properly. The splice loss lines must be set to overlay the back scatter 
of a trace without over lapping any other events. Unlike basic splice loss, LSA measurement areas are drawn as 
straight lines without regard to the undulations of the back scatter.

7.10 Loss Measurement Settings
Touchscreen Tip
The loss measurement/LSA areas may only be set with the key pad. Use the menu to enter the  
LSA settings function, but once there, use the key pad to adjust the areas as described. It is best  
to be zoomed in on an event to best set the loss measurement areas.

Setting Splice Loss Measurement Areas
To set the basic splice loss measurement/LSA areas, the OTDR must be in Splice AVG or Splice LSA mode. To adjust 
the splice loss areas around the cursors, press the Menu button, highlight the LSA icon and press Select. The splice 
loss position indicator will be displayed at splice loss position number 1, as indicated in Fig. 7.6. Use the left and 
right buttons to adjust the loss measurement area. Press the Select button to move the splice lose position indicator 
to the position number 2, set the area and continue with positions 3 and 4 in the same manner. Press Select when 
done with position number 4 to hide the splice loss position indicator and reset the focus of the keyboard back to 
the cursors. Press the Menu button at any time to escape the splice lose settings sequence.

Note
It is necessary to set these areas in clear back scatter to acquire the most accurate measurements (they must 
not include other events).

Splice Loss Adjustment Areas

Fig 7.5
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Splice Loss Adjustment Positions

Fig 7.6
LSA Examples

 Fig 7.7

 Fig 7.8

 Fig7.9
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The LSA area and cursor are set too early. The right most 
green LSA indicator line is not overlaying the back scatter 
of the trace properly.

The LSA area and cursor are set too late. The left most  
green LSA indicator line is not overlaying the back scatter 
of the trace.

The LSA area and cursor are set properly. The green LSA 
indicator line is overlaying the back scatter of the trace 
properly.
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7.11 Event Analysis
Note
When using the event table and the Fib-R-Map, it is necessary to keep in mind that event analysis  
provides approximate loss and distance measurements to quickly assist in network evaluation.  
Automatic detection results are not guaranteed and have their limits, possibly causing erroneous  
readings or detection failure. User interaction by interfacing with the trace display is recommended  
for final qualitative and quantitative analysis.

Enter Event Analysis
To enter event analysis, press the Menu button and use the left/right buttons to highlight the Event Analysis icon 
and press Select.

Note
All the entries on the parameter screen are operational with the touchscreen. To exit the parameter  
screen with touchscreen function, touch the Return button.

Threshold Settings
There are four threshold settings: EOF, Loss, ORL and Link (See Fig 7.4). The EOF is not a Pass/Fail threshold, it is used 
to set a loss value to determine the end of fiber. If the EOF threshold is set for 3dB, then the first event that has a 
loss of 3dB or greater will be deemed the EOF.

To change the threshold settings, press the Menu button, use the left/right buttons to highlight the Settings icon 
and press Select. The cursor is the yellow highlighted area. If the yellow cursor is on a value that is the current 
selection, that block will be highlighted green. The setting highlighted in blue is the current setting. Use the LRUD 
buttons to highlight the desired threshold category and press the Select button. Use the up/down buttons to set 
the digit, and use the left/right buttons to move to the next or previous digit. Once the desired setting is entered, 
press the Select button. Use the LRUD buttons to move to the next setting until all thresholds have been set as 
desired. To exit the parameter screen, press the Menu button.

Splice, ORL and Link are all thresholds for Pass/Fail purposes.

Note
Thresholds are "pass thresholds," a value entered as a threshold is a passing value.

Examples of these settings are as follows:
Splice:  If a 1.00dB splice loss is acceptable, set the threshold to 1.00. If a splice loss of 1.00 is the fail point,  

set the threshold to 0.99.

ORL:   If a -50dB reflectance is acceptable, set the threshold to 50. If -50dB is the fail point, set the threshold  
to 50.5.

Link:   If a 20dB, link loss is acceptable, set the threshold to 20. If 20db link loss is the fail point, set the  
threshold to 19.5.

Sensitivity Settings
There are three levels of sensitivity for the event table and Fib-R-Map (See Fig 7.4). To change the event sensitivity, 
press the Menu button, use the left/right buttons to highlight the Settings icon and press Select. The cursor is the 
yellow highlighted area. If the yellow cursor is on a value that is the current selection, that block will be highlighted 
green. The setting highlighted in blue is the current setting. Use the LRUD buttons to highlight the desired setting 
and press Select. To exit the parameter screen, press the Menu button.
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The lowest setting possible should be used to help filter out any false events that may be caused by short pulse 
widths, but are not true perturbations in the optical signal. High sensitivity presents events with loss down to 
approximately 0.1dB, Medium (Md) with events down to approximately 0.2dB and Low (Lo) for event down to about 
0.5dB. Longer pulse widths, and averaging help to lower the number of false events. Highest sensitivity settings 
should only be used for traces with high signal level, low noise, long pulse width and long average.

Macro Bend Analysis
Macro bend analysis is performed with the dual trace operation and displayed in the event table. The traces to be 
compared must have been performed at the same range and the primary trace must be of the longer wavelength.

To conduct a macro bend analysis, open the file manager as described in Chapter 9. Highlight the first trace to be 
loaded (the trace of the longer wavelength) and select to open. Open the file manager again and highlight the 
trace to be compared (the trace of the short wavelength), open the drop-down menu under the file tab and touch 
dual or use the up or down buttons to highlight dual and press Select. Open the event analysis screen to check for 
macro bends. If an event on the longer wavelength trace has 0.25db or greater loss, the same event on the shorter 
wavelength trace, a macro bend event will be generated on the event table, identified by a Macro label in the Type 
column. This event will immediately follow the event it is related to. For example, if event number one was 5 dB at 
1550nm and .5 db at 1310nm, the second event will be blank for location, +4.5dB for splice, blank for 2point and 
DB/KM. The type field will be listed as Macro.

To exit dual trace and macro bend analysis, simple start a new scan.

Event Analysis Screen

Fig 7.10
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Fib-R-Map

Fig 7.11
Note
The Link is the last item in the schematic view. It is labeled E in the event number position. The loss  
value just prior to this item is the Link Loss and the Event location above the item is the same as the  
location of the event deemed the EOF.

Event Table

Fig 7.12
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Table Definitions
# Event Number - Indicates the event in sequence, where the higher the number, the further distance from 
the OTDR the event occurs. “E” (End) is the event determined to be the End of Fiber (EOF). "L" is the link row and 
contains information about the entire link tested.

P- Pass/Fail, if any one of the thresholds are not met for and event, the P/F column will display a red F. The 
parameter that failed will also be displayed in red. If all the parameters are met, this column will display P. The Pass/
Fail threshold for the event labeled "L" is the loss displayed in the 2POINT column, the link loss threshold.

Km or KF or MI - Event Location, Km for Kilometer or KF if unit of measure is Kilo-feet MI for mile. This is the 
distance/location that the event occurs along the fiber link.

Splice - Event Loss, is the splice loss (event loss) of the numbered event. A positive number is the amount of 
loss and a negative number indicates a gain normally due to mismatched index of refraction. This is a selectable 
threshold for the Pass/Fail feature. The "E" event will display N/A as this is not an event that would have meaning. 
The "L" line of the table is the link and as such does not have an event (splice) loss.

2 Point - 2 Point Loss is the loss measured from the end of the dead zone of the previous event to the beginning of 
current event. The value in the "L" line of the table for this column is the link loss. The loss from the beginning of the 
trace to the event determined to be the EOF. This is the value used to determine if the fiber link passes or fails it's 
loss threshold.

dB/Km - dB per Kilometer if in KM, DB/KF if in Kilo-Feet and DB/MI if in mile unit of measure. This is the calculated 
loss per Km, Kf or Mi from the end of the dead zone of the previous event to the beginning of the current event. The 
value in the "L" line of the table for this column is the dB Per/KM, Kf or Mi for the total link.

Type - Event Type is the type of event or the ORL measurement. If the event has no reflection, “splc” will be 
displayed and if the event contains a reflection, the event reflectance value will be displayed. For the last event, 
which is labeled "L" in the # column, the value displayed is the system ORL.

Section 8 - Project Management
8.1 Project Management Description
Project Management allows the user to save a set of parameters to be recalled for use at a later time. It also 
incorporates the file management system to save traces to the active project folder. When the OTDR is turned on, 
the default project is [NONE]. If an existing project is not open or a new one is not set, all traces will be saved to the 
[NONE] folder.

Note
In the Project and File Management screens, the down button opens drop-down menus and moves the cursor 
down through the drop-down menus, and the up button hides the menu or moves the cursor up through the 
drop-down menus.

Note
It is necessary to create the project prior to taking a trace as the file will not be available to save after going 
through the project creation sequence.
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Project Management Screen

Fig 8.1
Project Management Menu
The menu for project management may be operated with the touchscreen, however, this manual describes the 
manner of operation with the keypad. To open the menu, press the Menu button. There are four tabs available: File, 
Edit, View and Help. Use the left or right buttons to move to a desired tab and use the Select or the down button to 
open the drop-down menus. Pressing the Menu button again or the up button will hide the Operations menu.

Fig 8.2
Touchscreen Tip
The menu may be pulled down with the stylus the same as the menu on the Main Trace screen. Once the File menu 
is open, it is fully operable with the touchscreen function.

Project Management File Tab
To open the drop-down menu under File, with File tab highlighted, press Select or the down button. Use the down 
or up buttons to move through the drop-down menu and Select to choose and operation. Selecting New will open 
a new project folder using the current parameter settings. Open will open the highlighted project. Dual is not 
operational in the project management and therefore greyed out. Delete permanently removes the highlighted 
project. The Delete button must be held for at least one second to remove projects. Once Delete is selected, the 
project and all files associated with that project are deleted. Use Exit to leave the project manager and return to the 
trace screen.

Fig 8.3
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Note
Once a project is established, the settings cannot be permanently changed. They may be changed  
temporarily, but the original setting will be defaulted every time the project is opened.

Project Management Edit Tab
To open the drop-down the menu under Edit, with the Edit tab highlighted, press Select or the down button. Use 
the down or up buttons to move through the drop-down menu and press Select to choose an operation. Upload 
is used to transfer files to the CertSoft software. Rename allows the highlighted folder name to be modified while 
maintaining all settings and associated files. Properties allows the user to edit the properties displayed at the 
bottom of the project window.

Fig 8.4
Project Management View and Help Tabs
View offers the user the opportunity to move to the File Manager from the Projects page. With View highlighted, 
press Select or the down button to open the drop-down menu. With the Files tab highlighted, press Select to move 
to the File Management page. For Onboard Help pages, highlight the Help tab and press Select.

Fig 8.5
8.2 Project Management Operation
Create a New Project
The parameters that are stored for a project are: range, pulse width, average, wavelength, distance units, pulse 
width units, event sensitivity and thresholds. To create a new project, press Menu, select the Settings icon, set the 
parameters as required. When all setting are established, use the arrow button to highlight the Return button or 
touch Return at any time while in the Settings screen. Press the Menu button, highlight the Project Folder icon and 
press Select. With the File Tab highlighted, press Select or the down button to open the drop-down menu. Use the 
down or up buttons to highlight New and press Select again. Use the onscreen QWERTY keyboard to name the 
folder and touch Save. The folder names are limited to 16 characters.

To enter details about the project, use the up and down buttons to highlight the project that was just created and 
press the Menu button. Use the left or right button to highlight the Edit tab, use the down button to highlight 
properties and press Select. Use the up and down buttons to select the desired field to be entered or modified 
and press Select. Use the QWERTY keyboard to enter the information and touch Save when complete. Up to 24 
characters may be entered for these fields. To exit the project screen, press Menu, press Select, use the down button 
to highlight Exit and press Select again.

Open an Existing Project
To open a project, press the Menu button, highlight the Project folder and press Select. Use the up or down buttons 
to highlight the desired Project folder and press Select. This will open the File Management screen listing all the 
files previously stored in this project. All saved traces will now be stored to this project until a new project is created 
or another project is opened.
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Delete a Project
To delete a project, with the project to be deleted highlighted, open the File drop-down menu, highlight Delete and 
press and hold Select. Ensure the proper project is selected because once deleted, the folder and files cannot be 
recalled.

Note
Delete must be held for approximately 1 second to complete the delete function.

Upload a Folder to CertSoft
To upload a folder and all it's associated files from the OTDR to the computer, open the CertSoft software and 
ensure the OTDR is connected to the computer with the USB cable.

Note
The two plugs in the top right corner of the screen should show as connected and green.

Highlight the project to be uploaded, press Menu to open File Manager menu, use the right button to highlight Edit 
tab, press Select or the down button to open the drop-down menu and with upload highlighted, press Select. The 
folder with all files will be uploaded to the target folder selected on the computer.

Rename a Project
To rename a project, have the project to be renamed highlighted, press Menu, to open the project management 
menu. Use the left and right buttons to highlight Edit tab and press select or the down button to open the drop-
down menu. Use the down button to highlight Rename and press Select. The project name will be displayed with 
the onboard QWERTY keyboard. Use the keyboard to rename the project and touch Save.

Modify Properties
To modify the properties, have the project to modify highlighted. Press Menu, highlight Edit/Properties and press 
Select. The project properties will be displayed, use the up/down buttons to highlight the field to be changed, use 
the onboard QWERTY keyboard to make the change and touch Save. Continue with the changes needed. When 
complete, highlight Close and press Select.

Use the left and right buttons to highlight Edit tab and press Select or the down button to open the drop-down 
menu. Use the down button to highlight Properties and press Select. The properties list will be display, use the up 
or down buttons to highlight the property to be modified and press Select. The QWERTY keyboard will be displayed 
with the property information. Press Save when done with the change. Continue with the changes needed. When 
complete, highlight Close and press Select.

Temporary Modification of Parameters
Test parameters may be temporarily changed by selecting new settings, such as wavelength, average time, pulse 
width, and range directly on the main OTDR screen with the touchscreen capabilities or open the Parameter 
Settings screen, set the new parameter and Save. All subsequent tests will use the new settings until the original 
settings are returned or the folder is reopened, resetting the project parameters. To make temporary changes to 
event sensitivity or thresholds, open the Parameters Settings page.

Exit Project Management
To exit the project management, press Menu, use the left or right buttons to highlight the File tab, press Select or 
the down button to open the drop-down menu. Use the down button to highlight Exit and press Select.

Section 9 - File Management
9.1 File Management Description
File Management is use to save and recall traces. It operates in conjunction with the projects manager in that if a 
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project folder is open, the files saved to and listed in the file manager are associated with the open project. When 
the OTDR is turned on, the default folder is [NONE], therefore, any files saved without opening a project will be 
saved to the [NONE] folder. Any files saved in the scope function will also be associated with the open folder.

File Management Screen
Fig 9.1

File Management File Menu
The menu for File Management may be operated with the touchscreen, however, this manual describes the manner 
of operation with the key pad. To open the File Management menu, press the Menu button.

Fig 9.2
Touchscreen Tip
The file menu may be pulled down with the stylus the same as the menu on the main trace screen.  
Once the File menu is open, it is fully operable with the touchscreen function.

File Management File Tab
To open the drop-down menu under File, with File highlighted, press Select or press the down button. Use the 
down or up arrow to move through the drop-down menu and press Select to open the highlighted operation. 
The operations are: Save, Open, Dual, Delete and Exit. Save stores the current trace, Open displays the trace that 
is currently highlighted, Dual opens a secondary trace, Delete permanently removes a file and Exit closes the file 
management screen.

Fig 9.3
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File Management Edit Tab
To open the drop-down menu under Edit, with Edit highlighted, press Select or press the down button. Use the 
down or up arrows to move through the drop-down menu and press Select to choose a highlighted operation. 
Upload is used to transfer the highlighted file to the CertSoft software. Rename allows the highlighted file name to 
be modified. Properties is grayed out and not accessible from this location.

Fig 9.4
File Management View/Help Tab
View offers the user the opportunity to move to the projects management page from the file management page. 
With view highlighted, press select or the down arrow to drop down the view tab and press select to move to the 
file management page. For onboard help pages, highlight the help tab and press select.

Fig 9.5
9.2 File Management Operation
Save a Trace File
To save a trace, press Menu, highlight the File Manager icon and press Select. Press Select or the down button to 
open the drop-down menu and with Save highlighted, press Select again. The file naming window will open and 
the onboard QWERTY keyboard will be available. Use the touch keyboard to name the file and touch Save. The 
file names are limited to 16 characters. This method should be used to set the base file name for a group of traces. 
These file names are saved exactly as entered. To save files with a chronologically numbered suffix, use the Quick 
Save. Quick Save uses the last enter base file name.

Open/View a Trace
To open a trace, press the Menu button, highlight the File Folder and press Select. Use the up or down buttons to 
highlight the trace to be viewed and press Select.

Dual Trace Mode
Dual Trace Mode may be used to view and compare two traces. Both traces must be of the same range setting. To 
utilize the Dual Trace feature, first open the primary trace as you would normally by highlighting the trace in File 
Management, pressing Menu to open the File Management menu. With File highlighted, open the drop-down 
menu, use the down button to highlight Dual and press Select. The trace opened using the Dual feature is the 
secondary trace and all information displayed is that of the primary trace. To exit the dual trace mode, start a scan 
with the Scan button.

Delete a File
To delete a file, with the file to be deleted highlighted, press Menu or the down button to open the file drop-down 
menu, use the down or up buttons, highlight Delete and press Select for at least one second. Ensure the proper file 
is selected because once deleted, the file cannot be recalled.

Note
Delete must be held for approximately 1 second to complete the delete function.
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Upload a Trace to CertSoft
To upload a trace from the OTDR to the computer, Open the CertSoft software and ensure the OTDR is connected to 
the computer with the USB cable.

Note
The two plugs in the top right corner of the screen should show as connected and green.

Highlight the file to be uploaded, press Menu to open File Manager menu, use the right button to highlight the Edit 
tab, press Select or the down button to open the drop-down menu and with upload highlighted, press Select. The 
file will be uploaded to the target folder on the computer .

Rename a Trace File
To rename a trace file, have the file to be renamed highlighted. Press Menu, use the left or right button to highlight 
Edit, press Select, or the down button to open the drop-down menu, press the down button to highlight Rename 
and press Select. The file name will be displayed with the onboard QWERTY keyboard. Use the keyboard to rename 
the project and touch Save.

Exit File Management
To exit the file management, press Menu, use the left or right buttons to highlight the File Tab, press Select or the 
down button to open the drop-down menu. Use the down button to highlight Exit and press Select.

Section 10 - Tunable Laser Source
10.1 Laser Safety
The Tunable Laser Source has been configured to provide laser 
radiation in the C Band of operation. (1530-1565nm) L Band may  
be available upon request with a range of (1565-1625nm). Please 
see the warning label in figure 10.1. This is displayed on the left  
side of the body of the TLS. The unit has been designed to comply 
with 21 CFR (Code of Federal Regulations) 1040.10 and 1040.11, for 
Class 1M emission limits. Although Class 1 levels are not considered 

Fig 10.1  

to be hazardous, we suggest limiting exposure by never looking directly into the optical aperture. Also, do 
not under any circumstance view or inspect the laser output fibers, connectors or the fiber under test through 
collimating or focusing optics unless the unit is turned off, batteries are removed and the power adapter  
is disconnected.

Caution
Personnel should always be aware when working with fiber optic test equipment that active  
fibers may be present, therefore infrared optical energy may be present.

Fiber optic connectors are easily contaminated or damaged. The connection to this tunable light source is a 
physical contact type of connection and dirty or damaged connectors will impair the instrument’s capabilities at 
the minimum and, at worst, result in the need to return the equipment to the factory for expensive repairs.

Caution
Never look directly into the end of a connected fiber optic cable or fiber optic interface of optical  
test equipment. To do so could expose the user to laser radiation and could result in personal injury.
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10.2 TLS Quick Start Guide
• Prior to any operation, please read the laser safety section of this chapter.

• To operate the TLS at a specific wavelength/frequency/channel in CW mode, follow this quick start guide.

• Touch the TLS icon on the Home screen.

•  The Laser Output is displayed in the center of the screen. Touch this value to cycle through units of: 
Wavelength (nm), Frequency (THz) and Channel (Ch). 0.4nm (0.05THz), 0.8nm (0.10THz) or 1.6nm (0.20THz).

•  Touch and hold the blue Wavelength/Frequency/Channel selector on the scale. Drag the selector to the 
desired output value.

•  Touch the Step Size indicator to cycle through step sizes until set at 0.40nm for wavelength, 50 GHz for 
frequency or 0.5 Ch for channel is displayed.

•  Touch the Power Value and a numeric keypad will be displayed. Enter the desired power value within the 
ranges set at the top of the display and touch OK.

•  Touch the Laser icon to energize the laser in a CW mode. Touch the Laser icon a second time to turn off  
the laser.

10.3 Operation
From the Home screen, touch the TLS icon to enter the tunable laser source feature.

TLS Screen Description

Fig 10.2
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Setting Parameters
Set Output Units
The output may be displayed in wavelength or frequency or channel. To set the units, touch the Output Value in the 
center of the screen to cycle through the available units.

Set Step Size
There are three available step sizes when selecting output or for sweep purposes. While in wavelength mode, the 
steps are 0.4nm, 0.8nm or 1.6nm. In Frequency mode they are 0.05THz, 0.10THz or 0.20THz, and in channel mode 
they are .5, 1 or 2 channel steps. The step size changes to the appropriate unit when the output units are changed. 
To set the Step Size, touch the Step Size indicator to cycle through the available choices.

Power Level
The power level of the signal is adjustable from approximately +7 dBm to +13 dBm in increments of 0.01 dBm. To 
set the power level, touch the Power Level indicator and a numeric key pad will be displayed. At the top of the key 
pad will be the available power level range. Enter the desired power to 0.01dBm. Once entered, touch OK or to back 
out without change, touch Cancel.

Dwell Time
To set the dwell time when operating in sweep mode, touch the Dwell Time indicator. A numeric key pad will be 
displayed. The dwell time may be set from 2.00 to 60.00 seconds for sweep mode operation. Enter the desired dwell 
time and touch OK or to exit without change touch Cancel.

Touchscreen Operation

Laser Start/Stop/ 
Activity Indicator Flashing indicates active laser/starts and stops laser/sweep

Home Icon Brings the user back to the home page
Help Icon Opens the context sensitive Help menu
Step Size Cycles through available step sized in nm, Freq, and Ch

Power Opens numeric keypad to enter power level
Dwell Time Opens numeric keypad to enter dwell time or CW mode

Output Value Laser output value in nm, Freq or Ch
Output Unit Indicates displayed output unit

Active Output Slide Used to select/indicate output laser
Channel Scale Full scale of available laser output
Low End Slide Used to select lowest laser output of sweep
High End Slice Used to select highest laser output of sweep
Snap to Lowest  

laser Output Moves the active slide to the lowest laser output set by the Low End Slide

Snap to highest  
laser Output Moves the active slide to the highest laser output set by the High End Slide

Laser Output Down Moves the low end slide down the scale
Laser or Sweep, Start/Pause Start and stops the laser/sweep

Laser Output Up Moves the high end slide up the scale
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A dwell time of 0.00 is used for manual operation. This will set the laser to a CW mode at the output value displayed. 
The output may be changed with either the active output slide or the up or down channel select buttons.

Set Low and High End Laser Output
To set the low end laser output, touch the Low end slide and release. The output indicator and the up and down 
arrows will change to green. The focus of the up down movement arrows and snap to end arrows changes to the 
low end slide. Use these arrows, or the slide to set the low end laser output.

Touch the red high end slide to change the output indicator and focus of the arrows to the high end slide to set the 
high end laser output.

Manual/CW Operation
To fire the laser in a CW mode, Set the output to the desired unit, set the step size, if required, and set the power 
lever to dBm level required. Set the dwell time to 0.00. When the laser is fired with the Laser Start/Stop/Activity 
indicator or the Laser or Sweep Start/Pause, it will be in CW mode. To change the output laser, use the arrows at 
the bottom of the display to move or snap the laser to a value or use the Active Output slide to set the desired 
wavelength, frequency or channel. Touch the Laser Start/Stop/Activity indicator or the Laser or Sweep Start/Pause 
again to turn off the laser.

Sweep Operation
To run a sweep of the laser, set the output to the desired unit, set the step size, power level and dwell time as 
described above. Use the low end and high end sliders to set the low and high end laser levels to be fired. Touch the 
Laser Start/Stop/Activity indicator or the Laser or Sweep Start/Pause.

Exit Tunable Laser Feature
Touch the Home icon to return to the home screen.

Warning
Even if the indicator shows the laser to be off, never look into the end of a fiber connected to the  
TLS or directly into the connector port. Do not, under any circumstance, view or inspect the laser output  
fibers, connectors or the fiber under test through collimating or focusing optics unless the unit is turned  
off, batteries are removed and the power adapter is disconnected.

Section 11 - Fault Locator
11.1 Fault Locator Description
The Fault Locator is a simple auto test feature which displays the test results in an event table with the Fib-R-Map 
schematic view. The fault locator will take a scan of the fiber in auto test mode. The user sets the wavelength 
to be tested and the OTDR will set the pulse width and range to best suite the fiber under test at the selected 
wavelength.

If Pass/Fail information is desired, first enter the OTDR mode and set the Pass/Fail threshold to meet requirements.

To enter the Fault Locator mode, touch the Fault icon on the Home screen. The screen below will be displayed. The 
first time the mode is entered it will be void if data, it may be populated with data from a previous session.

Fault Locator Screen
The fault locator screen includes the event table, Fib-R-Map (Schematic View) and event map view of highlighted event.
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Fig 11.1
Fib-R-Map

Fig 11.2
Note
The End of Fiber is the last item in the schematic view. It is labeled E in the event number position and displays 
a vertical Bar instead of horizontal.
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Event Table

Fig 11.3
Event Table Definitions
# Event Number - Indicates the event in sequence, where the higher the number the further distance from 
the OTDR the event occurs. “E” (End) is the event determined to be the End of Fiber (EOF). "L" is the link row and 
contains information about the entire link tested.

P - Pass/Fail, if any one of the thresholds are not met for and event, the P/F column will display an F. The parameter 
that failed will be displayed in red. If all the parameters are met, this column will display a P. There is no Pass/Fail 
threshold for the last event labeled "E" (End) and the Pass/Fail for the "L" (Link) row includes the 2POINT column, 
which for the link is the total link loss and the TYPE column which for the link row is the system ORL.

Km or KF or MI - Event Location, Km for Kilometer or KF if unit of measure is Kilo-feet MI for mile. This is the 
distance/location that the event occurs along the fiber link.

Splice - Event Loss, is the splice loss (event loss) of the numbered event. A positive number is the amount of 
loss and a negative number indicates a gain normally due to mismatched index of refraction. This is a selectable 
threshold for the Pass/Fail feature. The "E" event will display N/A as this is not an event that would have meaning. 
The "L" line of the table is the link and as such does not have an event (Splice) loss.

2 Point - 2 Point Loss is the loss measured from the end of the dead zone of the previous event to the beginning of 
current event. The value in the "L" line of the table for this column is the link loss. The loss from the beginning of the 
trace to the event determined to be the EOF. This is the value used to determine if the fiber link passes or fails it's 
loss threshold.

dB/Km - dB per Kilometer if in KM and DB/KF if in Kilo-Feet and DB/MI if in mile unit of measure. This is the 
calculated loss per Km, Kf or Mi from the end of the dead zone of the previous event to the beginning of the current 
event. The value in the "L" line of the table for this column is the dB Per/KM, Kf or Mi for the total link.

Type - Event Type is the type of event or the ORL measurement. If the event has no reflection, “splc” will be 
displayed and if the event contains a reflection, the event reflectance value will be displayed. For the last event 
which is labeled "L" in the # column, the value displayed is the system ORL.
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11.2 Fault Locator Operation
Set Wavelength
To set the wavelength, first enter the OTDR mode and touch the Lambda icon or Wavelength to open the 
Wavelength Selection pages. Use the touchscreen to select a wavelength or move to the next pages of available 
wavelengths.

Start Scan
To start a scan, touch in the bottom right corner of the display. A "Please Wait, Scanning" message will be displayed. 
The scan will take about 15 seconds.

View Test in OTDR Screen
To view a test in the full OTDR mode, touch an event in the table and the scan will be displayed in Trace mode with 
the active cursor at the selected event.

Exit Fault Locator
To exit the Fault Locator mode touch the Home icon.

Section 12 - Video Scope
12.1 Entering Video Scope Function
To operate the video scope, from the Home screen, highlight the Scope icon and press the Select button. If a probe 
is not connected already, connect the VIS300 video probe to the video probe port on the top of the OTDR.

12.2 Video Scope Display

Fig 12.1

Touchscreen Tip
The icons on the Video Scope screen are operational with the touchscreen feature, though this guide is written 
using the keyboard whenever it is available.

12.3 Video Scope File/Help Icon Menu
The icons at the top of the display are Home, File Save, Project Management, File Management and Help.

Home
Press the Menu button, use the left and right buttons to highlight the Home icon and press Select to return to the 
Home screen.

Quick Save
Press the Menu button, use the left or right buttons to highlight the Quick Save icon and press the Select button to 
store a file image of the Scope screen in the File Folder within an active project. Scope files will be preceded by a 
Target icon.
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Project Management
To open Project Management, press the Menu button, use the left or right buttons to highlight the Project 
Management Folder icon and press Select. Use the Project Management folder to open the project that the scope 
images are to be stored. When entering the Video Scope function, the Active folder will be the one last used in the 
OTDR or LTS. For more information about the project management system, please refer to Chapter 9 of this guide.

File Management
To open File Management, press the Menu button, use the left or right buttons to highlight the File Management 
icon and press Select. Use File Management to view a list of saved files or to open a stored image. File types are 
identified by the preceding icon: Trace files are indicated by a Trace icon, LTS file by an LTS icon and scope files are 
preceded by Scope (Target) icon.

Help
Press the Menu button, use the left and right buttons to highlight the Help icon and press Select to view the Help 
information.

12.4 Video Scope Operation Icon Menu
The following functions are only available for use when the Video Scope is in live scan mode.

Grading Rings
Used to turn on and off the rings that indicate the IEC61300-3-35 grading zones.

Enter the Menu mode with the Menu button, use the LRUD buttons to highlight the Pass/Fail Grading Rings Overlay 
icon and press the Select button. Exit the Menu mode and use the LRUD buttons to center the image in the rings. 
Use the Pass/Fail Criteria Tables to grade the connector end face. 2, 3, 5 and 10 micron contaminant examples are 
displayed just below the connector image on the Video Scope display.

Pass/Fail Label
The Pass/Fail Label is used to turn cycle through P/F (Pass/Fail) Off, P/F Man (In Red "Fail"), P/F Man (In Green "Pass") 
and P/F auto. To set the Pass/Fail indicator, press the Menu button, use the left or right buttons to highlight the 
Pass/Fail icon and press Select to cycle through the pass/fail states.

Touchscreen Tip
The touchscreen may also be used to make these selections.

Brightness
Press the Menu button, use the left and right buttons to highlight the Brightness icon, use the Select button to 
cycle through the adjustments for the brightness level.

12.5 Video Scope Operation
Video Probe Tips
There are a number of video probe tips available. To remove a tip from the Probe, grasp the probe tip and unscrew 
the tip retention nut from the tip. Pull the tip straight up from the probe. To place a tip on the probe, ensure the 
lens is clean, slide the tip on to the end of the probe and tighten the tip retention nut. Do not overtighten the 
retention nut.

Viewing/Focusing a Connector
With the video scope turned on and the video probe plugged into the OTDR, insert a connector into universal tip or 
insert the panel adapter tip into the appropriate port. The scope must be in the live scanning mode to make focus 
adjustments. Use the focus ring to get the connector image as sharp as possible. When using panel adapters, it is 
possible to turn the body of the probe while the adapter is inserted into the panel to make focus adjustments.
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Note
To make position adjustments with the LRUD buttons, the unit must not be in Menu mode.  
Menu mode is evident when there is a light blue box positioned around one of the icons. When  
the touchscreen is used to roughly center the connector image, the Menu mode is automatically  
turned off.

Centering a Connector Image
Once the image is stable and focused, use the stylus to touch the approximate center of the connector to snap the 
image near the center of the display and the center of the grading rings. Use the LRUD buttons to fine tune the 
image to the center of the display.

Pausing Image Scan
To freeze an image in position and focus level for inspection, press the Scan button. This will pause the image at the 
current position and focus level. Simply press the Scan button again to set the operational mode back to live mode 
for focus and position adjustments.

Grading Rings
Turn on or off the grading rings by pressing Menu and using the left or right buttons to highlight the Grading Ring 
icon and press Select. The unit must be in Live Scan mode to turn the rings off or on.

Manual Pass/Fail
Use the pass/fail criteria tables to determine if the connector passes the IEC61300-3-35 standard. There is a guide to 
contamination size located at the bottom of the image. To mark a connector as Pass or Fail, enter the Menu mode, 
highlight the Pass/Fail Label icon and press Select to cycle through pass, fail, or no grading. This must be done in 
the Live Scan mode. Once the pass/fail status has be entered, the scan may be paused with the Scan button and the 
points of contamination that caused a failure may be marked on the image.

Manually Marking Points of Contamination
To mark the points of contamination, the unit must be in Pause mode. Pick up the contamination marker by using 
the stylus and touching the contamination sample size that is required. Touch the image to place the marker. The 
marker may be fine tuned with the stylus to cover the contamination point on the image to be marked. Once the 
marker is positioned properly, touch the area just below the image that states, "Place marker, touch here to apply" 
to lock the marker in place. Repeat this as necessary to mark all the points that need to be indicated for the pass/fail 
status. At this point, the image should be saved with the Quick Save icon.

Note
Marking the points of contamination should be done last, just before saving the image. Once the  
unit is returned to live mode, the markers are removed.

Auto Pass/Fail
Once the image has been centered in the grading rings, set the P/F icon to Auto and press the Scan button. The 
video scope will evaluate the image and grade it with pass or fail. Contamination will be displayed on the image.

Exiting Video Scope Operation
Enter the Menu mode, use the left or right buttons to highlight the Home icon and press Select.
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12.6 Pass/Fail Criteria Tables

Fiber End Face Criteria Table for Angled PC Polished Connectors

Zone Description Diameter Allowable Scratches 
(Width)

Allowable Defects 
(Diameter)

A Critical Zone 0μm to 25μm ≤ 4μm None

B Cladding Zone 25μm to 120μm No limit
No limit < 2μm

5 from 2μm to 5μm
None > 5μm

C Adhesive Zone 120μm to 130μm No limit No limit

D Contact Zone 130μm to 250μm No limit None ≥ 10 μm

Fiber End Face Criteria Table for Ultra PC Polished Connectors

Zone Description Diameter Allowable Scratches 
(Width)

Allowable Defects 
(Diameter)

A Critical Zone 0μm to 25μm None None

B Cladding Zone 25μm to 120μm No limit ≤ 3μm
None > 3μm

No limit < 2μm
5 from 2μm to 5μm

None > 5μm

C Adhesive Zone 120μm to 130μm No limit No limit

D Contact Zone 130μm to 250μm No limit None ≥ 10 μm

Fiber End Face Criteria Table for SM PC Polished Conn. (Single Mode Fiber, RL≥ 26 dB)

Zone Description Diameter Allowable Scratches 
(Width)

Allowable Defects 
(Diameter)

A Critical Zone 0μm to 25μm 2 ≤ 3μm
None > 3μm

2 ≤ 3μm
None > 3μm

B Cladding Zone 25μm to 120μm No limit ≤ 3μm
None > 3μm

No limit < 2μm
5 from 2μm to 5μm

None > 5μm

C Adhesive Zone 120μm to 130μm No limit No limit

D Contact Zone 130μm to 250μm No limit None ≥ 10 μm
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Section 13 - Visual Fault Locator
13.1 VFL Safety
Caution
This Visual Fault Locator is classified as a Class II laser system and  
must be used with all commensurate safety precautions. Never  
view the light emanating from the fiber directly. Place a white  
piece of paper at the end of the fiber and look for the presence  Fig 13.1 
of a red spot on the paper.

13.2 VFL Description
The Visual Fault Locator emits visible (red) light at the 650 nm wavelength. It's intended function is to allow an 
operator to identify the exact location of a break, micro bend, or other discontinuity in a fiber optic cable. As the 
radiation is visible, light emanating from a break or micro bend enables the user to locate the exact position of a 
fault, even at very short distances that would not be detectable by conventional means such as an Optical Time-
Domain Reflectometer, (OTDR). It is also useful for identifying a particular fiber in a cable by exciting the fiber to be 
located with visible radiation.

13.3 VFL Operation
The Visual Fault Locator is access from the Home screen.

The fiber to be tested is connected to the VFL port of the OTDR by means of a standard 2.5 mm fiber optic 
connector. The source may be used in one of its two modes: Modulated or Continuous. In the Modulated mode, the 
laser is turned on and off at a 6 Hz rate. The laser is on for approximately one third of the cycle. This mode is helpful 
in permitting the user to identify the source radiation in the presence of high levels of ambient light. It also aids in 
conserving battery life.

The usable range for fault location depends on many factors: the type of fiber, the type of cable, the overall loss.

To activate the VFL, tap the VFL icon to cycle through the available states of off: Continuous and Modulated.

 Caution
  Never look directly into the end of a connected fiber optic cable or 

fiber optic interface of optical test equipment. To do so could expose 
the user to laser radiation and could result in personal injury.

 Fig 13.2

Optical Time Domain Reflectometer
Wavelength 1527.4 - 1565.4nm

Dynamic Range 35 dB
Pulse Width 5 - 20,000 ns

Units of Measurement Kilometer, Kilo feet and Mile
Event Dead Zone 1m

Attenuation Dead Zone 4m
Resolution .125 - 32m

Distance Uncertainty ± (0.75m + 0.005% x distance + sampling resolution)
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Optical Time Domain Reflectometer
Full Scale Distance Range 0.25-64km MM , 0.25-240km SM

Typical Real-time Refresh Rate 2 Hz
Group Index of Refraction (GIR) 1.024 - 2.048

Linearity ± .05 dB/dB
Memory Capacity ~1000

Memory Type Internal
Specifications are subject to change without notice

Visible Fault Locator

Emitter Type
Laser Photo diode 1100 - 1700nm InGaAs 

-70-+9dBm
with interchangeable FC Adapter

Laser Safety

Wavelength 650nm ±5nm
Connector Type 2.5mm Universal
Output Power 1mW Max.

Specifications are subject to change without notice

Tunable Laser Source

Range
Frequency 191.5 - 196.25 THz

Wavelengths 1527.4-1565.4nm
ITU Channels 15 - 62.5

Frequency Accuracy 1.5 GHz
Line Width 1 MHz

Side Mode Suppression Ration 45 dB
Maximum Output Power 13 dBm (Typ.)

Output Power Range 6 dB
Power Setting Resolution 0.01 dB

Power Variation Over  
Wavelength Range ± 0.5 dB

Minimum Channel Spacing 50 GHz (0.4nm)
Fiber Type 9/125 μm

Relative Intensity Noise -140 dB/Hz
Specifications are subject to change without notice
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13.1 Repair Information
If repair is required, simply call the Terahertz Technologies Inc., for return instructions and a RMA number.

13.2 Warranty Information
This product, including all mechanical, electrical, and optical parts and assemblies are unconditionally warranted to 
be free of defects in workmanship and material for a period of one year from the date of delivery.

This warranty does not apply to expendable parts such as batteries or optical panel connectors, nor to any 
instrument or component which has been subjected to misuse, alteration, or fiber connector damage. It is the 
customer’s responsibility to understand all the instructions and specifications prior to operating this instrument. 
This warranty does not extend to any loss or damage consequent to the failure of the warranted product.

Section 14 - Version Control
14.0 Version Control
Through a program of continuous improvement, the upgrade of the features and performance of this instrument 
are an ongoing process. The instrument firmware version is accessible in the lower right corner of the Home screen. 
The version changes and approximate release dates are as follows.

OTDR V1.0.0.2 - 05/2017- Original release
V1.0.1.4 - 05/2018- Added clean sweep operation

General
Display 4" color touch screen

Power Supply/Charger 100-240V universal
Battery Li-ion 10 hr typ.

Storage Temperature -20 °C to 60 °C
Operating Temperature Range 0 °C to + 40 °C

Dimensions (without rubber boot) 8.4607” L x 3.89” W x 1.65" H
(215mm L x 99mm W x 42mm H)

Weight 1.6 lbs.
Communications Ports USB-PC

Connector Styles FC and SC Interchangeable

Accessories Included
Universal power supply with mains for US, UK, CE and AU.  

Interchangeable FC and SC adaptors, WindowsTM Compatible  
Software, USB Cable, Manual on CD, 2 stylus and Rubber Boot

Specifications are subject to change without notice


